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Web Builder Introduction
Have you ever felt amazed at how things changed over the last years? The Internet has
become as common as the telephone. E-mail makes people totally forget about the
existence of regular mail. Having a web site is now more important than having a
business card.
Actually, many people now think that having one web site is not enough. Really, would
you present yourself the same way to your potential employers, family members and
former schoolmates? Of course not! On the first site you would probably place your
professional resume—and will refer to it in an employment classified. On the second, you
would place new pictures of you and your fiancé—you may want to share them with your
parents in Minnesota and your sister in Paris. On the third, you will open a picture gallery
out of the old school pics—maybe, this will help you find your old good friend whose
trace you lost many years ago…
And so, you have decided to make up your own website. High time! But do you know
enough HTML? Or do you want to create your site using a text editor? In either case, you
will end up spending days and days to have your site look attractive and getting all
things work. Not the best solution. Or, maybe, you want to pay hundreds of dollars for
the web designer to do the job?
Well, here is the solution. We will save your time and efforts, and what's even more
important, you can be personally involved in the Art of Web Design. To create a
professional-looking web site using Web Builder, you don't need any special knowledge
or experience. The wizard-like program structure will guide you through the whole siteconstruction process step by step. Now you become a web designer, a creator, an Artist!
You can juggle around with page layouts, colors, themes, add various effect and much,
much more, everything with a single mouse click! Within a half hour you can have your
site created and published on the Internet!

Add a Page in Web Builder
Web Builder allows creating websites in two categories: Personal and Small Business.
Each category serves its own purpose.
A site in each category constitutes of a series of pages, each devoted to a separate topic,
article or resource. Web Builder offers you a set of templates for all common pages:
To add a page to your website, click the Add A Page icon in the top panel.
Personal
In the Personal category you can create a site for your fiends, school-mates and
relatives. You can tell about yourself, your background, hobbies, share funny stories and
show your photographs. Here you can also post your resume for potential employers and
even more. To create your personal website, add any of the following pages:
• Splash Screen:
the home page or index page that welcomes visitors and contains references to all other
pages.
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• FlashSplash:
the home page or index page with Flash elements that welcomes visitors and contains
references to all other pages.
• About:
the page to provide information about the purpose, the owner of the site and any other
relevant data.
• Download Page:
the page where you can upload any files with descriptions to them. Visitors of your site
can later download them.
• Resume:
if you seek employment via the Internet, this is the central page containing short account
of your career and qualifications.
• Links:
the page where you list your favorite links to related websites or pages.
• Custom Table Page:
a page with any data organized in table format.
• Site Map.
If your site is becoming complex and hard to navigate, a site map will become helpful to
get around.
• Photo Album:
a sequence of pages containing images. You may want to use it for posting photos of
yourself, your friends, your family, your art works, postcards, etc.
• Your Own HTML.
This tool allows to copy-paste an existing HTML page and create a web page based on
your own HTML script. Recommended for advanced users.
• Humor:
a tool that helps you organize your jokes, funny pictures, humorous stories and other fun
topics.
• Survey Form:
a quick tool for drawing up visitor questionnaires.
• Generic Page:
a powerful tool to create pages with any layout, containing both text and images.
• Genealogical Tree:
a quick tool for creating a family tree. The output is a list of entries each devoted to an
ancestor or a family member.
• Calendar:
the page where you can list events with dates and comments.
• ICQ Contact Center.
If you extensively use ICQ, you will find this form of messaging the most convenient.
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• Driving Directions:
a powerful tool for visitors to get the driving directions to the place in North America that
you specify.
• Amazon.com Web Store.
If you want to offer your visitors some books for sale, this is the page for you. To use
this feature, you need to sign up with the Amazon.com associate program.
• Mobile Pager.
A page from which site visitors can reach you on a cell phone or a pager with Internet
messaging support. This feature is not currently supported by UK Mobile Providers, such
support will be added in due course
• External Page.
If you own two different sites or your friend or business partner own a website, you may
want to interconnect them. This page is most convenient to address site visitors to
different site.
Every time your site is visited, the first page to open would always be either FlashSplash
or Welcome Page, or Splash Screen. These page will also automatically include links to all
other pages you create. So, it would be a good idea to begin your site with one of them.
After choosing a page, click Next to continue with the design of the page.
Small Business
In the Small Business category you can create a site representing your company or
business. It's a good mean of telling about the history of your company, listing the
services you render or products/goods you sell. Here you can also create your own online
store, look for new employers and more. To create a business website, add any of the
following pages:
• Splash Screen:
the home page or index page that welcomes visitors and contains references to all other
pages.
• About:
the page to provide information about the purpose of the site, the owner of the site, and
any other relevant data.
• Generic Page:
a powerful tool to create pages with any layout, containing both text and images.
• Welcome Page:
the page allows to introduce all other pages on your site with images and short
descriptions to them.
• FlashSplash:
the home page or index page in Flash that welcomes visitors and contains references to
all other pages.
• Internet Links:
the page where you can list useful links to web sites or pages related to your business.
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• Download Page:
the page where you can upload any files with descriptions to them. Visitors of your site
can later download them.
• Firm Profile:
the page to introduce your company to the visitors of your site. You can edit and
organize the text layout for your Firm Profile page.
• Survey Form:
a quick tool for drawing up visitor questionnaires.
• Frequently Asked Questions:
the page to give answers to the most frequently asked questions about your business.
• News and Events:
the page where you can list important news and events of your company with dates and
comments.
• Careers and Jobs:
the page to announce about free vacancies in your company. Here you can give your
requirements for applicants and contact email.
• Driving Directions:
a powerful tool for visitors to get the driving directions to the place in North America that
you specify.
• Catalog Page:
the page to list your company products and goods with descriptions and images to them.
Use it to advertise your products or services.
• ICQ Contact Center.
If you extensively use ICQ, you will find this form of messaging the most convenient.
• Site Map.
If your site is becoming complex and hard to navigate, a site map will become helpful to
get around.
• External Page.
If you own two different sites and you want to interconnect them, this page is most
convenient to address site visitors to another site of your own.
• Contact Us:
the page providing detailed contact information about your company: postal address,
map, phones and staff members info.
• Services Page.
If you want to offer your visitors a range of services, this page is the most convenient to
present services with descriptions and images.
• Your Own HTML.
This tool allows to copy-paste an existing HTML page and create a web page based on
your own HTML script. Recommended for advanced users.
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• Add-A-Cart Catalog:
the page to create a fully integrated and usable on-line shopping system with secure
payment gateway and a merchant account.
Every time your site is visited, the first page to open would always be either FlashSplash
or Welcome Page, or Splash Screen. These page will also automatically include links to all
other pages you create. So, it would be a good idea to begin your site with one of them.
After choosing a page, click Next to continue with the design of the page

What is a Splash Screen?
Splash Screen is the home page that welcomes visitors and contains links to all other
pages.
To configure Splash Screen, fill out the Splash Page form:
• Splash Theme:
the main parameter that determines the look of your home page. Web Builder offers
several Splash Screen templates (themes). Choose one—you can change it any time in
the future. The current version of Web Builder does not provide immediate preview, so it
is recommended to configure it after you configure all other parameters (see instructions
below in this section).
• Logo image:
Splash Screen templates are designed to include a welcome image. You can select a
picture that is stored on your hard disk or has been already uploaded to your gallery. To
include a picture click the "Select Image" button and follow the on-screen instructions.
• Page Title:
This is the text that will show up on the welcome page in big letters. This would usually
be either the name of your site or a welcome sentence.
• Lock Splash Settings:
By default, Splash Screen is not affected by the global color settings for your site. Here,
you can allow Web Builder to modify Splash Screen properties by checking the No radio
button in the Lock Splash Settings field.
As you finish, click the Next button to save your settings. The View tab (see Tabs for
details) will open for preview. How do you like your welcome page?
Okay, now let us look back at the themes. Click the Edit tab and select a different theme,
then go to the bottom of the page and click Next. Try other themes to choose the best
one.
Important: your site will be published to the Internet only after you press the Publish link
on the menu bar, in the upper left-hand corner of the screen.
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What is a FlashSplash?
FlashSplash is the home page in Flash that welcomes visitors and contains links to all
other pages.
To configure FlashSplash, fill out the FlashSplash page form:
• FlashSplash Theme:
the main parameter that determines the look of your home page. Web Builder offers
several Splash Screen templates (themes). Choose one—you can change it any time in
the future. The current version of Web Builder does not provide immediate preview, so it
is recommended to configure it after you configure all other parameters (see instructions
below in this section).
• Page Title:
This is the text that will show up on the Welcome page in big letters. This would usually
be either the name of your site or a welcome sentence.
• Lock Splash Settings:
By default, FlashSplash page is not affected by the global color settings for your site.
Here, you can allow Web Builder to modify FlashSplash properties by checking No radio
button in the Lock Splash Settings field.
As you finish, click the Next button to save your settings. The View Tab will open for
preview.
Okay, now let us look back at the themes. Click the Edit tab and select a different theme,
then go to the bottom of the page and click Next. Try other themes to choose the best
one.
Important: your site will be published only after you press the Publish link on the menu
bar, in the upper left-hand corner of the screen.

The 'About' Page
The About page is commonly used to provide the following blocks of information:
• The purpose of the site;
• The owner of the site (a person or a company);
• Any other relevant data.
Enter your text into the boxes provided. Paragraph headings are optional.
Web Builder allows you to include a picture into the About page. This could be a picture
of yourself (for a personal site), your working team (for a company), a logo or any other
relevant image. To include a picture, click the Select Image button.
Then follow the on-screen instructions.

8

After you add an image, its thumb view will become available in the form, as well as a
Remove Image button. Click it to remove selected image from the About page.
After you key in or copy/paste the data you want to show on your About page, click the
Next button to save your settings, and you will be brought to the View tab.

The 'Welcome' Page
The Welcome page can be used as the home page that welcomes visitors and
automatically contains links to all other pages that are taken from the titles of the latter.
When you change the title of any page, it will reflect on the Welcome page as well. It
introduces visitors with all other pages on your site with images and short descriptions to
them.
To configure the Welcome page, fill out the page form:
• Page Title: enter the text that will show up on the Welcome page in big letters. This
would usually be either the name of your site or a welcome sentence.
• Page Text: enter some general introduction to this page.
• Title: this field automatically shows the webpage title. Though you still can edit it.
• Description: enter short description of this page. This text will appear under the Title.
Enter your text into the boxes provided. Paragraph headings are optional.
Web Builder allows you to include a picture into the Welcome page. This could be your
picture, a logo or any other relevant image. To add a picture, click the Select Image
button. Then follow the on-screen instructions.
After you add an image, its thumb view will become available in the form, as well as a
Remove Image button. Click it to remove selected image from the Welcome page.
After you key in or copy/paste the data you want to show on your Welcome page, click
the Next button to save your settings, and you will be brought to the View tab.

The 'Resume' Page
This is the central page for those who seek employment via the Internet. It provides an
easy-to-use wizard that allows you to effectively manipulate the data you would like to
include into your resume.
As the first step, you will see seven boxes with suggested section headings, each with an
Add button on its right.
1. Click the Add button to enter data into the relevant section.
2. Fill the new form that appears and press Next. The information you entered will show
on the main Resume page together with the Edit and Delete buttons.
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3. Click Edit if you want to change contents of the box, and Delete if you want to clear
the contents.
4. Follow this instruction for every section you want to include into your resume. Note: In
the Experience section form, you will have an in-built form for job duties. The
instructions are exactly the same as above.
Attention: Make sure you don't add empty forms! They will be included into your resume,
too.
You can preview your resume at any moment by clicking the View tab (see more on
Tabs). All your changes will NOT be lost. At the end, however, don't forget to confirm the
changes by pressing the Next button!
Now that you see your resume in a complete form, you may see how to make it more
visually appealing. Click Settings tab to change color, font or style (see more on Tabs).
When you have your web page in front of your eyes, you may decide to change the order
of some paragraphs. It's simple and fast.
• Click the Order Elements link to re-order your paragraphs. A new window will appear.
• In the box, click to highlight the name of the item you want to move;
• Use the up and down buttons to move the selected item up or down the list;
• Click the Next button to save changes and return to the Resume Edit page.

The 'Links' Page
Part of expressing yourself through a web page is including links to your favorite web
sites. The links you choose to include on your page can communicate your interests and
hobbies. A carefully designed collection of related links can make your site a good
launching place and will help you promote your site.
• Header Text:
The text that shows at the top of the Links page as a header. It usually details the page
or serves as a header to the introductory paragraph.
• Paragraph:
The introductory paragraph to the Links page.
• Columns of Links to Display:
Links can be organized into multiple columns.
• Addbutton is used to create a new Link category.
To keep your links organized, Web Builder places new entries into categories. To add a
category or links to your Links page:
• Click the Add button. This will call another form.
• Enter the name of the category;
• Click Add (Add Link);
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• Fill in the fields (Site title and Site URL), than click Next to continue;
• To add link, click Add;
• To make some changes, click Edit;
• To delete link, click Remove;
• Click Next when finished.
To edit an existing category:
• Click Edit button;
• Edit the name of the category;
• Click Add to include a new link;
• Click Next to save changes.
To delete an existing category, click Delete button. Warning: All links contained in this
category will be permanently deleted!

The 'Custom Table' Page
Custom page table is a page with any data organized in a table format. To create a table,
fill out the form:
• Border:
enter a numerical value representing the width of grids in pixels. To hide grids, leave the
field empty or enter 0.
• Width:
Table width can be indicated in pixels or in percent of the page width. To enter width in
percent, put the "%" symbol after the numerical value.
• Cell Padding:
distance from text to border, both vertical and horizontal.
• Align:
aligns the table on the page.
• Resize:
Enter the number of rows and columns for your table and press Resize button before
clicking Next.
If you want to group and join some cells, check the corresponding boxes and click the
Join Selected button.
Note: If you input an incompatible set of parameters, Web Builder will optimize conflicts
in these data.
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The 'Site Map' Page
This page shows the structure of your site. It is generated automatically and does not
allow editing. However, you can configure its settings, just like you it for other pages.

The 'Photo Album' Page
For you, a photo gallery may become the central element with photos of yourself, your
friends, your family, your art works, postcards, etc.
To create a photo album, fill out the fields in the form as the first step:
• Title:
the text that shows at the top of the menu bar.
• Select numbers of pictures per page:
Mind the size of your pictures. It is recommended that all your pictures fit one screen.
Follow the simple rule: the bigger the image size, the fewer pictures per page.
• Enter the number of columns:
Change this parameter depending on whether your images have a horizontal or a vertical
layout.
In the next step, add images to the Photo Album:
• Click Add. A new form will appear;
• Fill in the picture title and the date in any format;
• Click the Select Image button. You will be brought to the Upload Images page. Follow
on-screen instructions to add a new image.
• Add details. This may be a description of the place or names of people in the picture.
• Click the Next button to proceed.
To change or remove images, use the buttons under the Image.
To add more images to your album, click Add and repeat the steps above

The 'Your Own HTML' Page
This tool allows you to copy already existing HTML page and paste it into the input box.
However, it is recommended that you create your files in specialized html editors. Before
publishing this HTML page, you can choose whether it will use its own titles and layout,
or those provided by Web Builder.
- If you want to insert your HTML page with originally created layout, click Yes in Include
layout code?.
- If you want Web Builder to insert all the headers, titles, select NO in the Show as is
option.
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To upload a file from your hard drive, click the Upload File button at the bottom of the
page.
When uploading your own HTML page, try to avoid non-Latin characters, spaces,
underlines, commas, dots, hyphens, etc. It is recommended that your file name only
includes letters of Latin alphabet and numbers.

The 'Fun' Page
Fun page template helps you organize your fun topics. To add an item, click the Add
button for the appropriate category and fill out the form that appears.
To add pictures to your Fun Page:
• Click Add in the in the Add Funny Pictures box. A new form will appear.
• Enter the name of the picture.
• Click the Select Image button. You will be brought to the Upload Images page. Follow
on-screen instructions to add the new image.
• Add text. This may be any comment to the new image.
• Click the Next button to proceed.
• Click the View tab to see the page preview.
• Click the Edit tab to continue editing the page.
To change or remove images or texts, use the Edit and Delete buttons on the left of the
picture or text.
To add more images to your album click Add and repeat the steps above.
To change the order of the jokes, images or stories, click the Order Items button in the
appropriate form. A new form will appear. Follow on-screen instructions to change the
order of the items in the topic.

The 'Survey Form' Page
This template will help you develop a custom online questionnaire. Use it to research
public opinion or to get feedback from your customers.
To generate a questionnaire, fill out the form:
Page Title:
Page title is the text that will show at the top of the menu bar. For convenience, it
duplicates the same field in the Settings tab. In this field, you can change Web Builder
default name from "Survey" to, say, "Questionnaire" or "Feedback".
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E-mail To:
Here, enter the address where you want the survey results e-mailed. It can be the
Webmaster's (i.e. your) address as well as any other address you specify.
Questions:
To add a question, click the Add button on the right. A new form appears. Checking "Yes"
in the Is The Answer Required field marks the survey question with a red asterisk. The
survey will not be accepted from a visitor If one or more asterisked questions remain
unanswered.
The Question Type determines the format of the suggested answer:
• True/False: the answer should state true or false.
• Yes/No: the answer should be Yes or No.
• Single Line: the answer should fit in one line (for a bit complex questions).
• Multiple lines: for more comprehensive interrogative answers.
• Date: the answer should contain a date.
Carefully fill out this form and click the Next button to proceed.
On Successful Submission of the Form:
Here, enter the text you want the visitor to see after the form has been accepted.
On Error Submission of the Form:
Here, enter the text you want the visitor to see after the form has been rejected or an
error occurred.
Click the Next button to generate the questionnaire.

The 'Generic' Page
Generic Page template has been designed to enable fast and simple creation of custom
pages that do not fall into any other categories. You can choose how to lay out your
images and text depending on your tastes, needs and circumstances.
• Marquee:
This is a scrolling area of text. To add a marquee, click Add link. A marquee form will
appear. Enter the text you want to scroll, width and height in pixels, scrolling speed,
horizontal page alignment and vertical screen position, and the font style. Press the
Submit button to proceed.
• Number of Columns:
Multiple columns for the whole page can be combined with individual paragraph design.
• Choose Title For this Page:
Page title is the text that will show at the top of the menu bar. For convenience, it
repeats the same field in the Settings tab.
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• Choose Link Text:
This text will show on other pages as a hyperlink to this page.
• Edit Paragraphs:
You can add, delete and edit only individual paragraphs, including headers, body texts,
images and image titles. All elements are optional!
• Subpages:
Webpages hidden under hyperlinks, available from the Generic page but invisible from
the main menu.
To add or edit Paragraphs:
• Click Add or Edit. A new form will appear.
• Select paragraph layout by sliding you mouse over the buttons at the bottom of the
page and clicking one of them.
• Enter Paragraph Header;
• Click the Select Image button to add a picture;
• Enter Paragraph Text;
• Click Next to preview.
If you want to address site visitors to some subpages, unavailable from the main menu,
make sure to fill all necessary fields to make it work.
To add or edit Subpages:
• Click the Add button in the Subpages section. A new form will appear.
• Choose the number of columns from the drop-down box. It's the way paragraphs will
be arranged on this subpage.
• Type Title for this subpage. It'll show as subpage name when you link subpages to
paragraphs on the Generic page.
• Make sure to enter Link Text for this paragraph. It will show on the Generic page as a
hyperlink to this page. Without a Link Text, site visitors won't find a link that addresses
them to Subpages.
• To add paragraphs, click the Add button. - Enter Paragraph Header;
- Click the Select Image button to add a picture;
- Enter Paragraph Text;
- Select paragraph layout by sliding you mouse over the buttons at the bottom of the
page and clicking one of them.
• Click Next to preview. The paragraph appears in the Edit paragraphs section.
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To access subpages from the Generic page, link Subpages to paragraphs:
1. Click the Edit button near the necessary paragraph in the Edit Paragraphs section.
2. Select the corresponding subpage name from the Link to subpage drop-down box.
3. Click Next to proceed.
4. Click Next again to preview the Generic page.
To remove subpages or paragraphs, click the Delete buttons on the left.
To change the order of subpages, click the Order button. A new form will appear. Follow
on-screen instructions to change the order of the items in the topic.

The 'Family Tree' Page
Your family page includes two major blocks of information, one about the whole family,
and the other about its individual representatives.
To provide general family information, enter the following fields:
• Title:
It could be as generic as "My Family" or as specific as "The Simpson's Family Tree".
• Header Text:
give some introductory information about your family.
• Family Portrait:
Click the Select Image button to add a picture from your computer.
To provide information about individual family representatives:
• Click the Add button. The Family Member form will appear.
• Fill out the form. (Note: The date format does not matter). It is recommended to start
your Family Tree with the ancestors.
Warning: Clicking the Delete tab will remove the whole Family Tree Page, not a family
member page! To remove individual persons from the family tree, click Next in the
Family Member form to return to the Family Tree form and click the Delete button on the
left of the person’s name.
On the Family Tree central page you can see the general family genealogy information.
To view individual family member’s page, click this person’s name. To return to the
general family page, click Back to Family Tree at the bottom.
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The 'Calendar' Page
The calendar is nothing but a page listing events like birthdays, anniversaries, etc.
• Date:
this field is insensitive to the format of the date.
• Headline:
what is the event about. E.g.: "Our fiftieth wedding anniversary".
• Text:
the optional comment you may want to add. E.g.: "Not celebrating".
• Type:
the color in which the record will appear:
o Usual—green;
o Important—blue;
o Alert—red.

The 'ICQ Contact Center' Page
If you extensively use ICQ, you will find this form of messaging the most convenient.
To add the ICQ Contact Center page, fill out the fields:
• ICQ Number:
your active ICQ number to which the messages will be directed. You can copy it from
your ICQ View/Change My Details window.
• Subject:
Every message directed to you by a visitor of your site will have this subject included. A
good name for the Subject would be something like "Sent From My Site".
• Online Indicator Type:
Your ICQ-message page contains an online indicator that shows your current status (e.g.
online or offline). Here, you can choose how you want it to look. To preview, click the
View tab. To continue editing, click Edit tab.
• Status Indicator Description:
The text that appears next to the online indicator. You can change the default text to, for
instance, "The Webmaster is". Some indicator types include text like "My current status
is:" For these types, keep this field blank.
Press the Next button to proceed.
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The 'Driving Directions' Page
This is a powerful tool for visitors to get the driving directions to any address in North
America that you specify. For a personal site, this can be your home or hangout. For a
business site, show the location of your restaurant, store (supermarket) or a service
center.
To create the page, make sure to properly enter the details of the destination address
and press the Next button to preview. It will result in the amp itself.
To change data, click the Edit tab.
Important: The Get Directions button will work only in the published site. You won't be
able to check Directions until then.
Please note that driving directions are not a part of Web Builder, those are third party
products and even minor changes on the corresponding site can break links to the map.
We are trying to track any changes, but in case there are some problems, we bear no
responsibility for broken links and incorrect maps.

The 'E Store (Amazon.com Web Store)' Page
To create your online bookstore, do the following steps:
1. Sign up.
You need to sign up to become an Amazon.com associate. You can sign up or find more
about the associate program.
2. Fill out the form
• Associates ID:
After you subscribe with the associate program, you will be assigned an associate ID.
Enter it into this field.
• Create Your Sales List:
enter the names, prices, and descriptions of the books you want to sell. Then press Next
to preview.

The 'Mobile Pager' Page
Configuring mobile messaging with Web Builder is as simple as entering the phone or
pager number, selecting service type and provider and clicking the Next button.

The 'External' Page
To configure External Page, enter:
- URL that addresses site visitors to an external website;
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- Button text that will appear on the Site Map, Welcome, Splash Screen and other pages
and tell site visitors about its relation to your site.
You can name the External page, say, Our Partner, Our friends or Our associates in the
Button text.
Make sure to click the Next button to save changes.
It's important to know that this page will be available for viewing only after publishing.

The 'Add-A-Cart Catalog' Page
You are now able to create a fully integrated and usable on-line shopping system. To do
it, add the BUY buttons created by Add-A-Cart to the catalog page created with Web
Builder. The Add-A-Cart shopping system also creates multi-functional online e-shop that
can be easily referred to.
With this e-commerce-solutions system you will have everything you need to operate a
successful on-line business: a shopping cart, secure payment gateway and a merchant
account issued by One Stop Merchant Services.
Generating the Buy button for the Add-A-Cart catalog page.
You need to log into your Add-A-Cart Admin page. In case if you do not have the Add-ACart account, you need to open it using the link on the editing page of Web Builder.
There are two instructions to get a snippet: for new and existing items:
To generate code snippets for a new item:
1. Click the Add New Item button on the main Admin page.
2. Enter all Item's information into the form.
3. Click Add Item.
4. Copy either the Dynamic Link the first code generated on the page or Static HTML the
second copy to clipboard button.
5. On the Web Builder catalog page, insert the code into the Web Builder edit page.
To generate code snippets for existing items:
1. Click the Edit/Delete Item button.
2. Click the Edit image (looks like a floppy disk) next to the item you want to edit or
generate code for.
3. Make changes if you want, though you don't have to do it.
4. Click the Update button.
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5. Copy either the Dynamic Link the first code generated on the page or Static HTML the
second copy to clipboard button.
6. On the Web Builder catalog page insert the code into Web Builder edit page.

The 'Download' Page
The Download page is a simple page where you can upload any files with descriptions to
them. Subsequently, visitors of your site can download them.
To provide general information, enter the following fields:
• Title:
enter the name of the page. This text will show at the top of the menu bar.
• Introduction:
give some introductory information about downloaded resources.
To provide information and a link to an individual file, click the Add button.
On the Download page, enter the following information about the download element:
• Element name: a name or a title of the file to be downloaded.
• Description: enter a description to this file, some useful additional information.
To upload files onto the website, do the following:
1. Click the Upload file button at the bottom of the page.
2. You will be brought to the Uploader page. Follow on-screen instructions to upload the
new file.
3. Click the Save button to save the file on your website.
4. Click the Next button to preview.
5. To add more files, repeat all steps from clicking the Add icon.
- To edit the files, click the Edit icon next to the necessary file.
- To remove file, click the Delete icon against the file.
Make sure to click Next to save all changes.

The 'Internet Links' Page
Part of introducing your business through a web page is including links to resources
related to your industry. A carefully designed collection of related links can make your
site a good launching place and will help you promote your site and business.
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• Header Text:
the text that shows at the top of the Internet Links page as a header. It usually details
the page or serves as a header to the introductory paragraph.
• Paragraph:
the introductory paragraph to the Internet Links page.
• Add Category button is used to create a new Internet Link category.
To keep your links organized, Web Builder places new entries into categories. To add a
category or links to your Internet Links page:
• Click the Add button. This will call another form.
• Enter the name of the category;
• Click Add (Add Link);
• Fill in the fields: Site title, Site URL and short description of the Internet resource you
are linking to.
• Click Next to continue;
• To add link—click Add;
• To make some changes—click Edit;
• To delete link—click Delete;
• Click Next when finished.
To edit an existing category:
• Click the Edit button;
• Edit the name of the category;
• Click Add to include a new link;
• Click Next to save changes.
• To change the order of products, click Order and follow online instructions.
Make sure to click Next to save all changes.
To delete an existing category, click the Delete button. Warning: All links contained in
this category will be permanently deleted!

The 'Firm Profile' Page
One more way to introduce your business and tell visitors about different areas of
company's activity is to create the Firm Profile page. It's also a good place to show
pictures of your staff, partners, describe social activities or professional services offered
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by your company.
• Page Title:
the text that shows at the top of the Firm Profile page as a header.
• Page Intro Paragraph:
The introductory paragraph to the Firm Profile page.
Click the Add button to create a new Firm Profile. It will call a new form.
• Enter the Paragraph Header—short introductory text about the paragraph.
E.g: if you dedicate the Firm Profile to your staff, Paragraph Headers can serve as names
and positions of your co-workers.
• Click the Select Image button if you want to upload image to this paragraph. Follow onscreen instructions to upload the image. Later you can remove the image by clicking the
Remove Image button.
• Enter Paragraph Text;
• Choose the template for the paragraph from the options listed;
• Click Next to continue;
• To add one more paragraph, click Add and repeat all steps;
• Click Next to preview page;
• To make some changes, click Edit;
• To delete paragraph, click Delete;
• Click Next when finished.
• To change the order of paragraphs, click Order and follow online instructions.
To save changes, make sure to click Next.
Did you find this a

The 'FAQ' Page
The FAQ page is used to provide detailed answers to the most commonly asked questions
about the industry of your business.
To configure the Frequently Asked Questions page, do the following:
Give general information:
• Page Title: enter the text that will show up on the Frequently Asked Questions page in
big letters.
• Intro Paragraph: enter some introductory information about this page.
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Add questions by clicking the Add button and fill out the form that shows:
• Question: enter question to be answered on this page.
• Answer: enter the answer to this question.
• Click Next to save changes.
• To add more questions, click the Add icon again and repeat previous actions.
• To make some changes, click Edit;
• To delete paragraph, click Delete;
• To change the order of questions, click Order and follow online instructions.
Once you completed the page, click Next.

The 'Catalog' Page
This page allows to list your company products and goods with descriptions and images
to them. Use it to advertise your products or services.
To configure the Catalog page, enter general information in the form as the first step:
• Title:
the text that shows at the top of the menu bar.
• Show products per page:
Mind the size of your pictures. It is recommended that all your pictures fit one screen.
Follow the simple rule: the bigger the image size, the fewer pictures per page.
In the next step, add images to the Catalog Page:
• Click Add. A new form will appear;
• Enter the Paragraph Header;
• Click the Select Image button. You will be brought to the Upload Images page. Follow
on-screen instructions to add a new image.
• Add details to the Paragraph Text. This may be a description of your products or goods
in the picture.
• Add optional Buy Now button:
- click the Select Image button. You will be brought to the Upload Images page. Follow
on-screen instructions to add your own image of the Buy Now button.
- enter Link to Shop and Button Description.
• Choose image and text appearance in the catalog from the templates listed below.
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• Click the Next button to proceed.
Catalog Page can be edited:
• To add more products with images, click the Add icon and repeat previous actions.
• To make some changes, click Edit;
• To delete paragraph, click Delete;
• To change the order of products, click Order and follow online instructions.
Once you completed the page, click Next.

The 'News and Events' Page
The News and Events page is a good way to inform your site visitors about the up-todate events of your company, e.g: presentations, conferences, seminars, corporate
receptions, issuing new products and etc.
Page Title is a text that shows at the top of this page as a header. It can serve as a
header to the introductory paragraph.
Intro paragraph is introductory information about your company's history. To add a
paragraph:
• Click Add in the paragraph section.
• Enter the Paragraph header: this text will serve as a name or introduction for the
paragraph.
• Click Select Image to upload the image. Follow on-screen instructions to add a new
image.
• Enter Paragraph Text. This could be some short information about the history of
company's events or description of company's most important event.
• Choose Image and Text Appearance for the news from the templates listed below.
• Click Next to save paragraph.
News serve for posting specific dates and related events. To post your company's news
or events:
• Click the Add button in the News section. It will call a simple form.
• To fill the form, enter the Date and Description of the date.
• Click Next to save news.
Click Next to preview the newly-created page.
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The News page can be edited:
• To add more Intro paragraphs/News, click the Add icon and repeat previous actions.
• To make some changes, click Edit;
• To delete paragraph, click Delete;
• To change the order of products, click Order and follow online instructions.
Make sure to click Next to save all changes.

The 'Careers and Jobs' Page
This template will help to post your announcements about free vacancies in your
company on the Careers and Jobs page with all necessary requirements and contact info.
Page Title is a text that shows at the top of this page as a header e.g:"Our Vacancies",
"Find a Job" etc. It can also serve as a header to the introductory paragraph.
Intro paragraph is introductory information about free vacancies in your company or your
business partner.
Text is an optional field. Here you can say, for instance, "Our current positions are:".
To configure this page and add as many positions as you need:
• Click Add.
• Enter the Position title, there can be several positions.
• Enter the Requirements for this positions: specific knowledges, experience, personal
features.
• Leave a Contact email.
• Click Next to save position and get to the intro page.
Positions can be edited:
• To add more positions, click the Add icon and repeat previous actions.
• To make some changes, click Edit;
• To delete a position, click Delete;
• To change the order of positions, click Order and follow online instructions.
Make sure to click Next to save all changes.
Did you find this an
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The 'Services' Page
This page is most relevant if your company specializes in rendering services. On the
Services page you can describe all services provided, their prices, conditions.
To provide general services information, enter the following fields:
• Page Title:
The text that shows at the top of the Services page as a header.
• Services Intro Paragraph:
The introductory paragraph to the Services page.
• Services Secondary Paragraph:
Optional field where you can post additional information about services or post
something like "The services we provide are:"
To add services, click the Add button. It will call a new form:
• Enter the Title of the service.
• Enter Link Label that will show as the title in the list of services at the top of the page
(or press Same as Title if you want this link and the service title to be the same).
• Enter the description and other relevant info about the service in the Text field.
• Click Next to save info about the service.
The Services page can be edited
• To add more services, click Add and repeat all steps;
• To make some changes, click Edit;
• To delete services, click Delete;
• Click Next when finished.
• To change the order of products, click Order and follow online instructions.
Important: the peculiarity of the Services page is that the user should fill all the service
fields. If some of the fields are left blank, you may have empty input boxes on this page.
So, if there are not enough links to enter, it would probably be better to use the Generic
page.
Make sure to click Next to go to preview page.
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The 'Contact Us' Page
The Contact Us page is a detailed description of your company's contact info. It has the
same functionalities as the About and Welcome pages, but includes more specific
information.
To configure the Contact Us page, fill out the form:
Enter general information:
• Page Title: enter the text that will show up on the Contact Us page in big letters. This
can be the name of your company or something like "Our Contact Info" etc.
• Page Intro Paragraph: enter some general introduction to this page.
Enter your postal address:
• Select your country from the drop-down box;
• Enter your Street address and building.
• Optionally, enter one more optional address if your company has two different offices;
• Enter the City your company is situated.
• Enter State (for non-US companies—province, county, district etc);
• Enter Zip code.
Other contact Info:
• Enter Phone and Fax numbers;
• Enter your company contact Email address;
The Contact Us page also allows to attach a map that will help to get to your company.
There are two options to add a map: either the one generated with Mapquest or a map of
your own.
Mapquest takes the address you have entered in the form above and generates a map.
To add a map:
• Select Enable for Request for Map at Mapquest
• To address your site visitors to the map, you can:
- Create a Text for a Link;
- Select a Button image.
Important: The Search Location on a Map link will work only in the published site. You
won't be able to check any maps until then.
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Please note that Mapquest is not a part of Web Builder, it's a third party product and
even minor changes on the corresponding site can break links to the map. We are trying
to track any changes, but in case there are some problems, we bear no responsibility for
broken links and incorrect maps.
To add a map created by yourself:
• Select Disable for Request for Map at Mapquest.
• Click the Select Image button. Then follow the on-screen instructions.
Note: After you added an image, its thumb view will become available in the form, as
well as a Remove Image button. Click it if you want to remove selected image from the
Contact Us page.
To add info about your partners or staff members:
• Enter Header for this section;
• Click the Add button. It will show a form.
• On the form that shows, enter the Name, Title and Email of the company
representative.
• Click Next.
• To post more associates info, click Add.
• To edit staff member info, click Edit;
• To delete info, click Delete;
• To change the order of products, click Order and follow online instructions.
On your Contact Us page, an info request from will show. Site visitors can fill the form
and submit it to the email address you have entered above. You can add your own texts
for error/successful submission of this form.
Click the Next button to save all your settings, and you will be brought to the View tab
(see Tabs for details).

What are the Tabs for?
Look at the tabs right under the toolbar menu. They supplement every page-designing
tool:
Edit tab opens by default, suggesting that you should enter or change your data before
viewing it. Forms in the Edit tab vary greatly from page to page.
View tab allows you to view your changes. This option is always available when you work
on Edit or Settings tab. This means that after you introduce any changes to your page
data or settings, you can immediately view them by clicking the View tab.
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Settings tab. Here you can customize all parameters for your page. For details go to
Standard Settings Tab.
Delete tab permanently removes the page from your site.
Note: You can switch between tabs to change any data or settings any time during the
page construction process or later.

The Rich Editor
Rich Editor is a multi-function Web Builder tool that provides a number of features for
creating and editing pages. Rich Editor is very much like MS Word or any other editor
which makes it easy for you to use. This tool is available only under Internet Explorer
(Microsoft) and in Web Builder it can be available in any pages with input boxes.
With Rich Editor you can easily copy any table, image or text from a browser and paste it
to the Web Builder rich editor page. To do this, select text in the browser or in text
processor and paste it to the page with.
Important: If you copy an image from a browser and publish it on your site, it will be
linked to the original location. If the website, where you have taken the image, changes
its location, you may face some problems. Therefore, you'd rather upload images to Web
Builder using the Image Uploader.

The Standard Settings Tab
Page Title
Page title is the text that will show at the top of the menu bar. In this field, you can
change Web Builder default name from "Fun Page" to, say, "Laugh with us".
Button Text
This is the text that will show up on your site’s menu among other page names. It may
be the same as the Page Title, or you can give it a different name. For example, if your
Page Title is "Fun Page", you may want to add some versatility by typing something like
"Smile!"
File Name
Technically, your site is nothing but an organized inter-linked group of html pages (files).
Web Builder enables you to assign a specific name for every page that you add to your
site. It is recommended that your file name only includes letters of Latin alphabet and
numbers. Try to avoid non-Latin characters, spaces, underlines, commas, dots, hyphens,
etc.
Title, Text, Heading
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You can select:
• Font - use pull-down menu;
• Color - click on Change color button, when the color scheme appears, click on Selected
color;
• Lettering Style—simply click on letter symbol.
After you change the settings click Next to see the result.
Rollover effect
When you move your mouse over some elements on a page, they may change their
color, shape and other properties. This is called Rollover Effect.
Background Image
You can place the contents of your page on an image. However, try to be discreet with
choosing the background. Avoid using photographs or bright decorations, as they may
hinder text readability.
Colors
Web Builder allows you to change the color palette for every site's page. Their default
HTML codes are in the boxes next to the parameter names. You don't need to know these
codes. Instead, click the icon to call a Color Picker—a palette with colors available—and
select the color you like. The "Color" section allows you to change background, text and
links color. Just select the element you wish to modify and click on the color you like.
Note: If you decide to change background color, ensure that the text on your page is
clearly readable. There must be sufficient contrast between the text and the background
image. A background with too much contrast competes with the text for reader's
attention and makes it difficult to read.
Banner
A couple of designs in Web Builder allow adding banners on user sites: Stylish Oval (for
both website categories) and Strong (for Small Business category ). In this case simply
enter the HTML banner code into the Add your banner code input box on the Settings
tab.
In other designs, users can add banners only as images with hyperlinks by entering the
banner code in any of the Paragraph boxes under the Edit tab.
Disable banner on this page: Check this box if you want to avoid adding banners to this
page.
Secure
You can make your page open to general public or closed (secure). Secure sites or pages
are often used by multinational companies to communicate closed information to its
representatives worldwide, where e-mailing is not appropriate.
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To secure restrict access to the page, choose Yes. The frame will expand to include a
drop-down list box where you can choose who is allowed to view the page: none, all
users, some users, some groups, some IPs and domains.
• Choosing none will disallow access to this page for all users
• Choosing all users will open access to this page for all users
• Choosing some users will open access to this page for specific users. To open them an
access, check boxes near the users and click Next to proceed.
• Choosing some groups will open access to this page for the chosen groups. To allow
access, check the chosen groups and click Next to proceed.
• Choosing some IPs and domains will open access to this page for specified IPs and
domains.
To allow access for specific IPs and domains, enter IPs and domains into the Some IPs &
Domains to Allow box separating them with hard return.
To restrict access for specific IPs and domains, enter IPs and domains into the Some IPs
& Domains to Deny box separating them with hard return.
To create an authorized user or user group, go to Site Settings -> Edit Security
Information (for comments see Edit Security Information help section).
Invisible Pages
From version 1.6RC1 and higher, Web Builder allows to avoid linking pages to site
navigation menu. Visitors won't be able to see such pages from the website menu and
from the Site Map page. However such pages are available from the top Web Builder
panel - Site Map.
To make page invisible from the menu, click the Page Settings tab, scroll down to the
bottom the page and check the Make this page invisible box. Make sure to click Next to
proceed.

Adding Plug-ins
With 1.6RC3 Web Builder offers additional plug-ins: guest book, counter and online poll.
• Guest Book allows to see the feetback posted by the visitors of your website.
• Counter allows to view statistics of visits to your website.
• Online Poll: choose it to get your visitors opinion about your website or services in a
form of a questionnaire.
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Uploading Images
If you want to upload an image to your webpage, click the Select Image button and you
will see the Image Uploader page. In Web Builder you can upload images from your
computer, from your image gallery and from the gallery provided by your hosting
provider.
To upload image with Rich Editor, click the image button on the Rich Editor page.
• Upload: upload files from your computer.
You can upload images into the folder images/ or create new destination subfolder.
To upload the image:
1. Click Browse and go to the directory or folder on your computer where your picture is
saved.
2. Select the picture you want to add to your page
3. Click the Open button. The location of the selected file appears in the "Upload Image"
window.
4. Click the Save button in the "Upload Image" window.
You can upload up to 5 files at once.
• Your Gallery: choose from the images that you have uploaded before.
• Our Gallery: select images from the Web Builder provided by your hoster. Users can
use these images, but they can't upload or change images in this gallery.
• Options: choosing this tab will bring you to the Gallery Options page.
Here you can:
- Show images with the following extensions in your gallery: gif, jpg/jpeg, png and bmp;
- Show/not show image thumbnails;
- Set Thumbnail size (one of 3 options);
- Sort images by name, size and date (in ascending or descending order).
Make sure to click the Save button to save all changes.
Clicking the lens icon in the image gallery will zoom the image out.
Clicking the Resize Image icon will let you change image size.
If you resized image in Our Gallery (customer's gallery), then the resized copy will be
stored in Your Gallery. The reason is because user has no permissions to resize or
change images of the provider's gallery.
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Order Pages
To re-order your pages do the following:
• Click to highlight the name of the page that you want to move;
• Use the and buttons to move the selected item up or down the list;
• Click the Next button to save changes.

Site Map function
Here you can see and inspect all the web pages your web site consists of.
• to preview page content click View. You will be brought to the page’s View tab.
• to change, add or delete info—click Edit. You will be brought to the page’s Edit tab.
• to delete the page click Remove. The page will be permanently deleted.
• to change the look and feel of the page, click Settings. You will be brought to the Page
Settings tab.
Important: Whatever long the page title is, it will show only 25 symbols on the Site Map.
For example, title Johnsons Family Genealogical Tree will show as Johnsons Fa...
Genealogical Tree.
The same length preserves for page titles under the toolbar on the top of the page,
between the Delete and View tabs.

Site Settings
This is wher you can get help with:
• Website Category;
• Website Colour & Style;
• Global Settings (General Contact Information);
• Website Theme/Effects;
• Load/Save Website;
• Start Over;
• Refresh Images;
• Change Language;
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• Edit Security Information.
• Edit Info for Search Engines
Note: When available, use the navigation buttons inside the browser window. For some
pages, your browser's Back and Forward buttons will not work correctly. If a page fails to
load, or does not reflect last changes, click your browser's Reload or Refresh button to
update the page.
Website Category
Web Builder allows creating websites in two categories: Personal and Small Business.
Each category serves its own purpose. A site in each category constitutes of a series of
pages, each devoted to a separate topic, article or resource. Web Builder offers you a set
of templates for all common pages.
In the Small Business category you can create a site representing your company or
business. It's a good mean of telling about the history of your company, listing the
services you render or products/goods you sell. Here you can also create your own online
store, look for new employers and more.
In the Personal category you can create a site for your fiends, school-mates and
relatives. You can tell about yourself, your background, hobbies, share funny stories and
show your photographs. Here you can also post your resume for potential employers and
even more.
To select a website category:
1. Click (highlight) the category that corresponds to the kind of web site you want to
build.
2. Click NEXT to proceed with creating of your web site.
You will be brought to the Select Website Color and Style page.
Attention: Once you begin to create your site you may not change the website
category!!! To change the category, you will have to start anew, which will delete ALL
PREVIOUSLY SAVED SITES.
Website Colour & Style
Choosing a correct layout is crucial for the success of your web site, as it will determine
the look of every page. Web Builder is equipped with a number of pre-designed Overall
Site Layouts. Go through the list in the upper left box by mouse-clicking each item or
using cursor keys on your keyboard. Sample pages will be shown in the preview window
on the right. Stop on the one that will best suit the contents of your site.
Then, select a color scheme in the lower box. It will only affect the menu bar; colors for
every individual page are set at a later stage (see Standard Settings Tab).
You can change your layout and color scheme any time in the future without losing any
information whatsoever, even when the construction of the site is complete.
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Selecting Site Layout
The checkbox allows you to apply selected layout and color scheme to all pages on your
site. It comes checked by default. If you uncheck it, the layout and color settings will
only affect the pages you create after applying these changes; the pages you created
before will remain unchanged. Changing this option doesn't affect your settings in any
way, if you are only beginning to create your site.
After you select the layout and color settings, click Next to move on.
Global Settings
Web readers often want or need to contact the person who created and maintains the
web site. Global Settings form requires you to enter basic information that will help
identifying the site and its author after it is published.
Global Settings are different for Business and Personal category of websites.
For Personal category: enter your full name, email address, website name. Also enter
keywords and description of the website into the message boxes.
For Business category: enter your corporate email address, firm (company) name, logo
image, slogan line, street address1,nd street address2, the name of your city, state, zip,
phone and fax numbers.
In the Search Engine Keywords box enter the words or word combinations that
distinguish your site from all other sites on the Internet. They will be helpful when
somebody tries to find your site with a search engine. Think of the words that would be
most characteristic of your site.
In the Search Engine Description box enter a short description of your site, like an
answer to the question: What is it about? If an Internet user finds your site with a search
engine, this description will show right under the site name.
At this point, you are done with general site settings. Click the Next button to configure
individual pages.
Website Theme / Effects
Add themes and special effects! Make snowflakes fall down in the browser, add logos that
stay put as the user scrolls, and tons of other cool features, all with easy point and click
selection.
There are several check boxes to indicate and select the theme (javascript effects) that
you can see on your web page. Use pull-down menu for selection. Then, click Next to
preview.
Falling Things:
• Snow—the snowflakes will fall on your screen;
• Snow 1 - just the same action but another type of snowflakes;
• Leaves - the leaves will fall and fly on your screen;
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• Angels - the same actions but Angels (instead of leaves) will fall on your screen.
Items. Please use pull-down menu to select the number of snowflakes (leaves).
Theme 1. Here you can include the "Top down curtain" effect. Try not to include too
many effects.
Cursor pointer. Here you can select:
• Cursor text. The name of the web page will trail the cursor.
• Colorful tail. The colorful tail will follow the cursor.
Site logo. Specify where you want to place the Logo image.
Logo duration. Specify how long you want the Logo to show on the page after it is
loaded.
Alt text. Enter the tooltip text—a brief message that will pop up next to the cursor when
it stops over the Logo image.
Load/Save website
You can save up to five different versions of your site. Make sure the names you enter
reflect changes between versions.
Attention: Before retrieving a previously saved website, save your work! If you don't
save your current project, you will lose it. Web Builder can work with only one site at a
time.
Warning: Starting over will delete ALL PREVIOUSLY SAVED SITES. To start a completely
new site, you need to register as a new user.
Note: Saving your web site will not publish it. To publish your site, click the publish link
at the upper left-hand corner on the menu panel.
Start Over
Scrap all your pages with one click, and begin designing anew. Use this option only if you
are completely sure. There will be no way to get back your current pages if you start
over.
This option allows you to delete all your web pages with ONE click and start to design
from the beginning. Warning: You will lose your current site as well as ALL PREVIOUSLY
SAVED SITES. Don't use this function if you are not strongly sure!
Refresh Images
You would need to refresh images in the following cases:
• If ImageMaker has generated images incorrectly or there were some errors while
generating.
• If your provider moved a user account from one box to another and refreshing helps to
correct paths to images.
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To refresh images, go to the Site Settings menu and click Refresh Images.
Change Language
Web Builder offers 2 interface languages to work with: Russian and English. To change
language:
1. In the Site Settings menu click the Change Language link.
2. Simply choose necessary language from the drop-down box. Interface language will
change right away.
Keep in mind that if your website contains any pages, change of language can corrupt
these pages. Therefore, you need to Start Over or delete all pages to change the
language correctly.
Edit Security Info
You can make your site open to general public or closed (secure). Secure sites are often
used by multinational companies to communicate current information to its
representatives worldwide, where e-mailing is not appropriate.
To secure specific webpages, you should:
1. Configure access groups and users in the Site Settings menu.
2. Secure individual pages in the Page Settings tab of the specific page.
To configure users or user groups authorized to access your secure site, click the Edit
sec. info link in Site Settings:
1. In the Add Users section click the Add button.
2. In the form that appears, enter User Name, user Password and user Full Name.
3. Click Next to proceed.
4. In the Add Groups section click the Add button.
5. In the form that appears, enter Group Name and choose the users to be assigned to
this group.
6. Click Next to proceed.
Note: You can delete, edit and change the order of users and groups using the
corresponding manipulation buttons.
To secure individual pages, go to Page Settings tab (see Page Settings help section for
details).

37

Edit Info for Search Engines
Web Builder allows to edit description to robots.txt file. This file is used all over the world
by search engines to find the match to the search request. Search engine robots check
robots.txt file, which is a plain text file, in the root of each server.
Robots.txt implements the Robots Exclusion Protocol, which allows the web site
administrator to define what parts of the site are off-limits to specific robot user agent
names.
You can leave the following indexing information to the search engines:
• Allow all: allows all robots (spiders) to index your site.
• Deny all: denies indexing your site by robots (spiders).
• Pages to deny: this option allows to deny indexing pages by robots.
If it's the case, go to the "Settings page" of the page you want to deny and select the
option "Deny indexing this page by robots(spiders)"
• Allow all known: allows only known robots to index your site.
Here you can also add Additional files or directories to deny. Just enter the file or
directory name into the input box.
• Your own robots file: here you can specify your own robots.txt file.
If it's the case, enter robots.txt data into the input box. You can also add additional files
or directories to deny. Just enter the file or directory name into the input box.
Make sure to click Next to proceed.
Note: you can edit, delete and change the order of file and directory names that are to
be denied.

My images aren't uploading into the Web Builder, why?
There are some limitations on the size of images that you can load into the Web Builder
software, this is done to make sites appear quickly and also to limit bandwidth
consumption. The limit is 1MB. Reduce your images down to 72 dpi and you shouldn't
have a problem.

Where do I find the Web Builder?
Log in to your eXtend Control Panel and if you have the Web Builder the link to it will be
at the bottom right of the front page. Please note that not all accounts include the Web
Builder.
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The Web Builder has frozen on the Image Upload page. How
do I get off this page?
Change the URL to read
http://82.110.105.5:8080/servlet/psoft.masonry.Builder?action=sitemap and press
return. That will take you back to the Sitemap.

Web Builder no longer allows me to do anything! The usual
menus are no longer available for me to navigate around.
This can be caused by an abrupt interruption in a network connection. You can recover
from this by altering the url (address bar) in your browser from :
http://82.110.105.5:8080/servlet/psoft.masonry.Builder?action=last
to the following :
http://82.110.105.5:8080/servlet/psoft.masonry.Builder?action=sitemap
which will recover the navigation menus.

Can I publish Web Builder pages under sub domains?
Unfortunately this is a limitation of Web Builder as this facility is not provided.
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